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What’s New in This Release
Note For more recent release note information, check Cisco Connection
Online (CCO) for possible updates. Refer to the last section of this release
note for access information.

What’s New in This Release
• The CiscoView 4.1(1) release supports

— HP OpenView 4.1, 4.11, 5.0, and 5.01 (HP-UX 10.1 and 10.2;
Solaris 2.4 and 2.5.1)

— NetView for AIX 4.1 and 5.0 (AIX 4.1.5 and 4.2)

— Solaris Site Manager 2.3/Domain Manager 2.3 (Solaris 2.4, 2.5.1, and
2.6)

— Enterprise Manager 2.0 (Solaris 2.4, 2.5.1, and 2.6)

• CiscoView 4.1 supports the following upgrade paths:

— Upgrade from CiscoView 3.1.1, 3.2, and 4.0

— Coexistence with CiscoWorks 3.2 and 4.0. On AIX, CiscoView
coexists with CiscoWorks 3.0.3 and 4.0

— Upgrade CiscoView within CiscoWorks for Switched
Internetworks 1.3 (CWSI 1.3)

CiscoView does not support an upgrade from CWSI 1.1 (on HP-UX
and AIX). To upgrade CWSI 1.1 to CiscoView, first upgrade
CWSI 1.1 to CWSI 1.3 (or higher), and then upgrade CiscoView.

• CiscoView is Year 2000 Compliant.

• CiscoView 4.1 for HP OpenView on Solaris is provided on the same
CD-ROM disk as CiscoView 4.1 for Solstice Site Manager, Domain
Manager, and Enterprise Manager on Solaris. In the previous release of
CiscoView, these products were on separate CD-ROMs.

Caution Before installing CiscoView or CiscoView devices, read the
caveats in “Installation Notes and Caveats” on page 11 to understand any
issues that might affect your platform.
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What’s New in This Release
Table 1 shows supported CiscoView devices by product type.

Table 1 Supported CiscoView Devices

Small to Medium
Business Products

Mid-Range Enterprise
Products 1

High-End Enterprise
Products

Cisco and CiscoPro 761,
762, 765, 766, 771, 772, 775,
776

Catalyst and CiscoPro switch
models2 1200, 1400, 1600,
1601, 1700, 1800, 1900, 2100,
2600, 2800, 2820, 2900, 2926,
3000, 3100, 3200, 3900, 5002,
and CPW2200

Catalyst 5000, 5500, and
5505

Cisco or CiscoPro 1003,
1004, and 1005

EtherSwitch Pro16,EPS2015,
1200, 1220, 1400, 1420

Cisco 7000, 7010, 7204,
7206, 7505, 7507, 7513
routers

Cisco and CiscoPro 1601,
1602, 1603, 1604, 1605

EtherSwitches: Pro16 and
CPW16

LS10103

Cisco 2501, 2502, 2503,
2504, 2505, 2507, 2509,
2510, 2511, 2512, 2513,
2514, 2515, 2516, 2520,
2521, 2522, 2523, 2524, and
2525

CiscoPro switch models
CPW10_100, CPW500,
CPW1200, CPW1220, and
CPW1400

CiscoPro 2051, 2052, 2503,
2504, 2505, 2507, 2509,
2511, 2513, 2514, 2516,
2520, 2521, 2522, 2523, and
2524

Workgroup concentrators
1400

Cisco and CiscoPro 3600
series (includes 3620 and
3640)

Fasthub 216T

Cisco and CiscoPro 4000
series4 (includes 4000,
4000-M, 4500, 4500-M,
4700, and 4700-M)

AS5200 Access Server AS2509-RJ
AS2511-RJ

AS5300 Access Server
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What’s New in This Release

10.3
Note Check CCO periodically for download information on the latest device
support and upgrades.

Other supported CiscoView applications are shown in Table 2.

Cisco 1501, 1502, 1503,
1516

NetBeyond Fasthub 300 and
Fasthub 100+ Series

EPS-500, EPS-1500,
EPS2115, CPW-500,
CPW-2115, and CPW-16

1. Adapters WA-C301TA, WA-C303TA, WA-C308TA, WA-C306TA, WA-C321T-PC, WA-C321T-UX,
WA-C323T-PC, WA-C323T-UX, WA-C326T-PC, WAC326T-UX, WA-C328T-PC, WA-C328T-UX
are no longer supported.

2. Catalyst 1000 and 1100 are no longer supported.
3. LS100 and LS2020 are no longer supported.
4. Due to a fix made for the BRI port problem, the Cisco 4000 series devices now support Cisco IOS

or later.

Table 2 Supported CiscoView Applications

Application Description OS Cisco IOS Device Support

Threshold
Manager

Monitors the
availability and
performance of Cisco
devices

Solaris 2.4, with
recommended patches as
of 3/16/95, Solaris 2.5.1,
and 2.6
HP-UX 10.01
AIX 4.2

Cisco IOS
11.1 or 11.2
with RMON
events and
alarms group
support

All devices with appropriate
Cisco IOS or RMON features

Table 1 Supported CiscoView Devices (Continued)

Small to Medium
Business Products

Mid-Range Enterprise
Products 1

High-End Enterprise
Products
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What’s New in This Release
The CiscoView devices packages included in this release are shown in
Table 3.

StackMaker Manages the device
membership in a
Cisco stack

Solaris 2.4, 2.5.1, and 2.6
HP-UX10.1 and 10.2
AIX 4.1

Cisco IOS
10.0 through
11.2

Cisco and CiscoPro 1600,
3600, 3620, 3640, Catalyst
1900, Catalyst 2820,
CPW1220, CPW1420,
Fasthub 100+ and Fasthub
300

Flash File
System

Provides file copying
and editing features
for the 7000 Series
routers

Solaris 2.4, 2.5.1, and 2.6
HP-UX 10.1 and 10.2
AIX 4.1.5, 4.2

Cisco IOS
10.0 through
11.2

Cisco 7000, 7010, 7204,
7206, 7505, 7507, 7513
routers

Cisco TN3270
Monitor

Monitor/configures
TN3270 capability
embedded in Cisco
devices with IBU
feature set.

Solaris 2.4, 2.5.1, and 2.6
HP-UX 10.0
AIX 4.1

Cisco IOS
11.0(13)BTor
11.2 with
cip22-14

Cisco 7000 and 7500 (with a
CIP card)

Table 3 CiscoView Device Package Versions

Device Package Version

1000.pkg 4.0(1.2)

1500.pkg 4.0(1.2)

1600.pkg 4.0(4.2)

2500.pkg 4.0(3.1)

3600.pkg 4.0(6.1)

4000.pkg 4.0(2.4)

700.pkg 4.0(1.4)

7000.pkg 4.0(3.0)

AS5200.pkg 4.0(3.1)

AS5300.pkg 4.0(1.1)

CPW10_100.pkg 4.0(1.4)

CPW1200.pkg  4.0(1.4)

CPW1220.pkg 4.0(1.5)

Table 2 Supported CiscoView Applications (Continued)

Application Description OS Cisco IOS Device Support
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What’s New in This Release
CPW1400.pkg 4.0(1.4)

CPW1420.pkg 4.0(1.5)

CPW16.pkg 4.0(1.1)

CPW2115.pkg 4.0(1.1)

CPW2200.pkg 4.0(1.5)

CPW316.pkg 4.0(1.4)

CPW500.pkg 4.0(1.1)

Cat116.pkg 4.0(1.4)

Cat1200.pkg 4.0(1.4)

Cat1600.pkg 4.0(1.2)

Cat1700.pkg 4.0(1.4)

Cat1800.pkg 4.0(1.1)

Cat1900.pkg 4.0(1.6)

Cat2100.pkg 4.0(1.4)

Cat216.pkg 4.0(1.1)

Cat2600.pkg 4.0(1.2)

Cat2800.pkg 4.0(1.4)

Cat2820.pkg 4.0(1.5)

Cat2900.pkg 4.0(1.7)

Cat3000.pkg 4.0(1.6)

Cat3900.pkg 4.0(1.1)

Cat5000.pkg 4.0(1.8)

Cat5500.pkg 4.0(1.7)

Cisco1516.pkg 4.0(1.1)

EPS2015.pkg 4.0(1.1)

LS1010.pkg1 4.0(1.4)

1. Please upgrade to LS1010 device package version 4.0(1.8). This
package can be downloaded from CCO.

Table 3 CiscoView Device Package Versions (Continued)

Device Package Version
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Cisco IOS Information
Cisco IOS Information
This section contains the latest Cisco IOS (Internetwork Operating System)
software version information at the time of printing.

CiscoView supports Cisco IOS software Releases 10.0 through 11.2. Access
servers require a minimum of Cisco IOS software Release 10.2. Cisco 3600
devices require Cisco IOS software Release 11.1 or later. Cisco 4000 series
devices require Cisco IOS software Release 10.3 or later.

Note CiscoView supports the Qualified Logical Link Control (QLLC)
feature in Cisco IOS software Release 10.3(7) through 11.x. CiscoView
supports the Synchronous Data Link Control (SDLC) feature in Cisco IOS
software Release 10.2 through 11.x. CiscoView supports the CIP card in
Cisco IOS software Release 10.2 through 11.x.

New devices and further specifics on Cisco IOS support will be updated as
devices become supported. For the online release notes, refer to one of the
following:

• Cisco Connection Online (CCO) in the Cisco Connection Documentation
section (continually updated)

• Cisco Connection Documentation, Enterprise Series CD

Note The Cisco Connection Documentation, Enterprise Series CD was
formerly called UniverCD.

Documentation Information
The documentation for CiscoView includes this release note, a CD-ROM
booklet, an overview manual, and online help. The primary documentation
for CiscoView is the online help. If you have documentation feedback, please
email comments to

bug-doc@cisco.com
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Incremental Installation Information
The documents shipped with this release include:

• Overview for CiscoView

• CiscoView CD Installation Instructions

• CiscoView Release Notes

Customer documentation can also be found on the Cisco Enterprise Customer
Documentation CD or on CCO.

Incremental Installation Information
There are several ways to add (or incrementally install) new devices to
CiscoView 4.1. For our direct customers, refer to the section “Cisco
Connection Online.” For our partner-initiated customers, refer to the section
“Partner Initiated Customer Accounts.”

You can add new devices to CiscoView from CCO or from the Network
Management Support CD. For more information, refer to the “Downloading
Device Packages” chapter inOverview for CiscoView.A quick reference
version exists in theCiscoView CD Installation Instructions booklet.

For Solaris:

Thepkgadd command is no longer used for installation. Please usesetup.sh.
See theCiscoView CD Installation Instructions booklet for the most
up-to-date version of install.

Partner Initiated Customer Accounts
To get more information about the Partner Initiated Customer Accounts
(PICA) program before accessing CCO for device package files, use the
following URL:

http://www.cisco.com/acs/info/pica.html

You can also refer to the “Downloading Device Packages” chapter in
Overview for CiscoView.
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Defects Fixed in This Release
Defects Fixed in This Release
The following problems in CiscoView 4.0(1) are fixed in CiscoView 4.1(1).
Table 4 lists only the most serious problems resolved in CiscoView 4.1(1).

Table 4 Defects Fixed in CiscoView 4.1(1)

CSCdj03079 Upgrade from cv311 to cv40 fails

CSCdj07135 10BaseT interface fails to Select

CSCdj07195 CiscoView install does not clean up before exit if disk full

CSCdj07710 Unable to configure cat 5000 port

CSCdj09056 CiscoWorks tools missing in CiscoView

CSCdj12055 CiscoView installation removes some of the symbols supported by CW
3.0

CSCdj12074 CiscoView deinstallation does not remove menu entry from NetView

CSCdj12860 SanFran:Etna module reports error messages while getting displayed

CSCdj14942 CiscoView: 5111 and 5011 cards don’t have link ports

CSCdj15629 CiscoView engine crashed due to continuously polling large table

CSCdj15790 7000 symbol registered for 7010 router in oid_to_sym

CSCdj17659 Cannot set Token Ring segment -cat1600

CSCdj18660 LS1010:LEDs on IBIS PAM not labeled

CSCdj26323 Fractional interfaces are displayed for one port only

CSCdj28590 ATM interface stats to be computed based on frames, not octets

CSCdj30092 HP-UX: Cannot modify VLAN Number in port config for Catalyst 5000

CSCdj30370 Errors during configuration - ERROR: failed to create /C/CiscoS

CSCdj35453 CW + CWSI 1.3 + CV 4.0 = Failure

CSCdj38584 Cannot configure due to missing fonts

CSCdj41569 CiscoView does not have a feature to deinstall a package

CSCdj57471 Warnings while invoking OVW (Duplicate definitions of Cisco Router)
CiscoView 4.1(1) Release Notes  9



Troubleshooting
Troubleshooting
If you cannot open a device in CiscoView 4.1, a message appears indicating
that the device is unmanageable for one of the following reasons:

• The Simple Network Management Protocol (SNMP) agent is not running
in the device.

You can still ping the device from the management station.

• You have entered an incorrect community string in the File>Open Device
window.

• The management station cannot reach or successfully ping the device.

• You have the wrong device package version.

Check your device package and compare the date with the version on
CCO. Upgrade your device package to the latest version, if required.

CiscoView Notes and Caveats
This section contains notes and restrictions that apply to the CiscoView 4.1
release.

• Installation Notes and Caveats, page 11

• General Notes and Caveats, page 15

Note For your reference, identification numbers follow the description of
the caveat, for example, [CSCdj00001]. If you need to contact Technical
Support about one of the following caveats, refer to the identification number
to speed the resolution of any questions or situations you might encounter.
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CiscoView Notes and Caveats
Installation Notes and Caveats
Installation notes and caveats for CiscoView follow:

Upgrading CiscoView 3.2.1 to CiscoView 4.1
After upgrading CiscoView 3.2.1 to 4.1, some links may remain in the
$SUNHOME/snm/agents directory, where SUNHOME is Solaris SunNet
Manager home directory (normally, /opt/SUNWconn). [CSCdj13160]

You can remove the links that point to invalid files by running the following
script:

#!/bin/sh

SUNHOME=/opt/SUNWconn
cd $SUNHOME/snm/agents
ls | while file=`line`
do

FILE=`ls -ld $file | awk '{ print $NF }'`
if [ ! -f "$FILE" ]; then

rm "$FILE"
fi

done

CiscoView 4.1 With HP OpenView 5.0/5.01
When a device package is installed, CiscoView updates HP OpenView with
the device symbols and bitmaps. If the CiscoView devices are shown as
default Network Devices icons in HP OpenView Windows, perform the
following:

#!/bin/sh
/opt/OV/bin/ovstart
/opt/OV/bin/ovstop netmon
cp /etc/opt/OV/share/conf/C/oid_to_sym /etc/opt/OV/share/conf
rm /etc/opt/OV/share/conf/C/oid_to_sym
ln -s /etc/opt/OV/share/conf/oid_to_sym /etc/opt/OV/share/conf/C/oid_to_sym
/opt/OV/bin/ovtopofix -a
/opt/OV/bin/ovstart netmon
CiscoView 4.1(1) Release Notes  11



CiscoView Notes and Caveats
CiscoView 4.1 With Enterprise Manager 2.0
Before integrating CiscoView 4.1 with Enterprise Manager 2.0, apply EM
patch 104170-04 to the Enterprise Manager installation. Without this patch,
the Enterprise Manager Discover utility will not discover Cisco devices.
[CSCdj63240]

CiscoView 4.1 Missing Fonts
If CiscoView fails to come up because of missing fonts, you can choose a font
by editing thecview.inifile, which is in the$NMSROOT/etc/cviewdirectory.
[CSCdj57455]

CiscoView 4.1 for Solaris/HP-UX Installation Warnings
Warnings and error messages that are generated when you incrementally
install device packages are logged into the log filedevinstall.log in the
CiscoView base directory (/opt/CSCOcvor /usr/nms/CVapp). You can use the
log file for troubleshooting if a device package installation fails. The file can
be cleaned up after a successful device package installation. [CSCdj47801]

CiscoView 4.1 for AIX Installation
If you are upgrading CiscoView 4.0(1) to CiscoView 4.1(1) and/usr/nms or
/usr/nms/CVapp is a symbolic link, the link is removed by SMIT (installp
utility). To overcome this, remove the link, mount the actual directory to
/usr/nms/CVapp,and perform the upgrade. You can also remove the previous
version of CiscoView and perform a fresh installation. [CSCdj41509]

CiscoView 4.1 Deinstallation
CiscoView does not remove symbols, bitmaps, fields, and MIBs from
HP OpenView/AIX NetView directories during deinstallation.

Deinstallation leaves the fileciscoview.schema in the
$SUNHOME/snm/struct directory. You should remove this file after
deinstalling CiscoView 4.1. [CSCdj62915]
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CiscoView Notes and Caveats
If CiscoView does not appear in the Tools menu in Solstice Site
Manager/Domain Manager, perform the following steps:

Step 1 Copy the file ciscoview.schema from the
$NMSROOT/etc/cview/snm/struct directory to
$SNMHOME/snm/struct, where NMSROOT is the CiscoView
home directory (typically /opt/CSCOcv).

Step 2 Edit the $SNMHOME/snm/struct/ciscoview.schema file and
replace the string “$NMSROOT” with your CiscoView home
directory.

CiscoWorks for Switched Internetworks 1.1 (for Solaris)
When CiscoView 4.1 is installed with CiscoWorks for Switched
Internetworks (CWSI) 1.1, you are unable to read VlanDirector help. This
error occurs when you selectHelp>VLAN  or Help>Contents. The
workaround is to log in asroot and enter the following at the command
prompt:

# cp /cdrom/install/.config/vlanview.hlp /opt/CSCOcv/help

[CSCdi84393, CSCdi84412]

CiscoWorks for Switched Internetworks (for AIX and HP-UX)
CiscoView 4.1(1) does not support an upgrade from CWSI 1.1. To upgrade
CWSI to CiscoView 4.1(1), first upgrade CWSI 1.1 to CWSI 1.3 (or higher)
and then upgrade to CiscoView 4.1(1).

CiscoWorks 2.x and CiscoView Upgrades
CiscoView 4.1(1) is not compatible with CiscoWorks 2.x. There are two
solutions. You can upgrade to CiscoWorks 3.2.1 or later or remove it.

Incremental Installation
Even when one package is being installed incrementally, CiscoView updates
HP OpenView/AIX NetView with symbols, bitmaps, and fields from all
installed device packages. [CSCdj41573]
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CiscoView Notes and Caveats
Errors Integrating MIBs into AIX NetView
Some errors will be reported during the installation or incremental installation
of device packages when MIBs are loaded into AIX NetView. For more
information and workaround suggestions, refer to the following URLs:

http://www.cisco.com/public/mibs/app_notes/mib-compilers

or

ftp://ftp.cisco.com/pub/mibs/app_notes/mib-compilers

Solaris/SNM
Update the path variable to include the path for the snm binaries and also set
the SNMHOME environment variable.

C Shell:

setenv SNMHOME /opt/SUNWconn/snm
set path=($path /opt/SUNWconn/snm/bin)

Bourne Shell:

SNMHOME=/opt/SUNWconn/snm
export SNMHOME
PATH=$PATH:/opt/SUNWconn/snm/bin
export PATH

The /opt/SUNWconn/snm directory is the default directory for SNM in
Solaris. If SNM is installed elsewhere, please change the SNMHOME and
path variables accordingly.

Solaris and SNM Patch Requirement
The SNM Discover utility will not work ifall the device packages are
installed for CiscoView 4.1. This bug requires SNM patches for SNM 2.3.
You can download the patches can be downloaded from Sun Microsystem’s
official patch site [CSCdj01623]:

ftp://zippy.telcom.arizona.edu/pub/snm/patches/Solaris2.x/SNM2.3/104018-02.tar.Z
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CiscoView Notes and Caveats
Solaris 2.5.1 and HP OpenView 4.1 Patch Requirement
The CiscoView installation on Solaris might fail if you do not install a
Hewlett-Packard patch. This patch is required to install NNM 4.1 on
Solaris 2.5.1 and must be installed before installing NNM 4.1. This patch is
required to run a license server on Solaris 2.5.1. If your license server is on a
different machine, this patch is not necessary.

Both patches consist of a tar file and a text file describing the patch. To obtain
a patch

Step 1 Enter the following URL:

ftp://ovweb.external.hp.com/pub/cpe/patches/nnm/4.1x

Step 2 Click on the appropriate links to get to your software patch.

Patch numbers are not available because HP consolidates the
patches periodically to contain all previous fixes. Select the one
related to Network Node Manager 4.1x by viewing the patch text
files. If you have difficulty installing the patch, contact HP Service
and Support.

Using pkgadd
The CiscoView installation uses the Solaris pkgadd utility. When pkgadd
finishes installing CiscoView, the screen shows that the installation was
successful but does not quit. TypeQ to exit the pkgadd utility.

General Notes and Caveats
The general notes and caveats follow. They are divided into six sections:

• Notes and Caveats for Enterprise Network Management Products
(including CiscoView and other products), page 16

• Notes and Caveats for Workgroup Products, page 19

• Notes and Caveats for Access Products, page 28

• Notes and Caveats for High-End Business Products (ATM switches and
the Cisco 7000, 7200, and 7500 series), page 33

• Notes and Caveats for Online Help, page 37
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CiscoView Notes and Caveats
Notes and Caveats for Enterprise Network Management Products

Config/Monitor for Multiple Ports
For some devices, config/monitor does not work for multiple ports.
[CSCdj65066]

CiscoView and Internationalization
CiscoView does not support internationalization.

CiscoView Times Out
In high traffic situations, you might experience timeouts. To increase the
timeout period, selectOptions>Properties from the CiscoView menu and
change the value for the Timeout field.

You should not reduce the physical view polling interval below
(retries*timeout), especially if you experience timeouts; this can exhaust
resources on Windows and result in a general error.

Dragging Ports
For this release, use the middle mouse button to drag on UNIX. Only certain
devices (such as the CAT1200, CAT1600, CAT5000, CPW16) have defined
their ports for dragging across devices.

HP OpenView
If a switch is configured as two or more domains, HP OpenView discovery
might not work properly and might discover only one of the domains. If this
occurs, use CiscoView to manage the domain directly rather than launching
the switch from the map.

By default, SNMP standard traps are logged in thetrapd.log file in HP
OpenView 4.1. To view the standard traps in the event window, use the
Option>Event Configuration menu to change the standard trap configuration.
[CSCdi91796]

Traps defined in the MIBBRIDGE-MIB.my are not loaded into
HP OpenView. Because of this, HP OpenView does not recognize the traps
newRoot and topologyChange. [CSCdj62552]
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CiscoView Notes and Caveats
Sometimes, because of font scaling problems, HP OpenView grapher cannot
be invoked. Refer to the description provided in the following app-defaults
file for HP OpenView grapher applications for more information.

/opt/OV/newconfig/OVNNM-RUN/app-defaults/C/XNm*

[CSCdj44163]

CiscoView Engine (for AIX only)
While some devices are being invoked, a number of MIB variables are
queried and the NetView grapher is invoked. Some of the queries might time
out often (three or more occurrences). If this happens, CiscoView does not
exit gracefully and produces a core dump. [CSCdj04380]

SunNet Manager/Enterprise Manager Issues
When you selectMonitor>Port  and invoke the Grapher, the Grapher does
not display the data. Currently working with Sun Microsystems to resolve this
problem.[CSCdj01623]

When you use CiscoView 4.1 with Enterprise Manager 2.0, sometimes the
em_discover application terminates abnormally. [CSCdj56566]

Open Look
• Popup menus might be out of focus. To correct the focus, move your

mouse pointer out of the window and back into the menu.

• Popup menus occasionally lose events in olwm. The menus always
appear, but you might not be able to select anything. If this occurs, move
your mouse pointer out and back into the menu to start tracking the events.
[CSCdi50535]

Popup Menu Titles
Popup menu titles are raised; users might mistake them for menu items.
[CSCdi53475]
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CiscoView Notes and Caveats
Printing to LaserJet III
CiscoView might fail to print to a LaserJet III printer, especially in the
“LaserJet” format, because of this printer's limited memory.

Running CiscoView 4.1 with Little Swap Space
If the server or display workstation is running out of swap space, you see a
message such as “X error: Couldn’t allocate color cell,” and CiscoView core
dumps. If you are running other applications, you should check your swap
space occasionally.

To check swap space on a Sun Solaris 2.x workstation, enter the following:

hostname% swap -l

If your system is running out of swap space (for example, only 200 KB of
swap space remains), quit some of the other applications you are running or
increase your swap space, if possible. [CSCdi37063]

StackMaker
Internal Debugging—When the StackMaker Debug option is set toOn,
debug messages print to the StackMaker Debug Log file. The default isOff .
The StackMaker Debug Log file stores messages that are useful in
troubleshooting problems. This log file is /tmp/.smDebugLog.

Internal Debugging—When the StackMaker Debug SNMP option is set to
On, SNMP debug messages print to the StackMaker Debug Log file on the
UNIX platform. The messages show the SNMP packets that have been sent
and received. The default isOff . The StackMaker Debug Log file stores
messages that are useful in troubleshooting problems. This log file is
/tmp/.smDebugLog.

Log File from Apply Operations—The StackMaker log file stores the results
of a saved stack configuration (Actions>Apply Stack Configuration). The log
file is /tmp/stackmkr/sm.log. When the log file exceeds 1 MB, it automatically
resets to 0 bytes.

When StackMaker is invoked on Catalyst 1900 devices, some debug output is
printed to the console. You can ignore this output.
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CiscoView Notes and Caveats
Threshold Manager
Some agents, most notably the Catalyst switches, impose a limit on the
number of alarm and event entries that can be created. Applying a large
number of thresholds to these devices will likely fail. In this case, some alarm
entries might be successfully created but their associated event entries are not.
These failed creations are marked asFailed in the Current Threshold Settings
pane. If you attempt to delete those settings, Threshold Manager reports that
the deletion failed (because it cannot delete nonexistent event entries.) In this
case, you can ignore the error message and can verify that the deletion
occurred by retrieving the threshold settings after the deletion.

New policies are always added to the display list.To view the new policies,
exit the Configure Thresholds window, then reopen it. [CSCdi62741]

Policy filenames do not match if the IP address is used. To correct this, use
the host name instead of the IP address when saving host-specific policies.
[CSCdi62739]

Duplicate global/device/host policies may be allowed, depending on which
window is used. When creating a custom policy, you can save it only once,
either as global, device, or host. But after saving the policy, you can use the
Modify Threshold Policy window to modify the saved custom policy and save
it as all three. [CSCdi68329]

Notes and Caveats for Workgroup Products

Catalyst 1200
When you use the Switch Zoom menu (if TrafficDirector is installed) from
CiscoView to view multiple switch ports, the default configuration for the
Catalyst 1200 is Statistics, Short-Term history, Long-Term history, and Host
group. To see the Short-Term or Long-Term history from Traffic Monitor, use
the Domain Manager to configure the Short-Term and Long-Term groups
manually or use Segment Zoom to view the port first.

When using the Segment Zoom menu from CiscoView to view the port
segment, the default configuration for the Catalyst 1200 is the Statistics,
Short-Term history, Long-Term history and Host group. For the Catalyst 5000
it is Statistics, Short-Term history, and Long-Term history.
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If you get the “Error: Entry or Group not present in Agent” message when
invoking Segment Zoom, Switch Zoom, or Data Capture, the write
community string might not be matched with the device. If the community
string is matched and the problem still occurs, use the CiscoView Configure
Device menu to see whether the RMON capability is enabled.

If you launch Switch/Port Zoom from CiscoView and then delete one of the
RMON Agents using TrafficDirector, you must relaunch CiscoView before
launching Switch/Port Zoom again.

If you see “IP address is not set in sysIpAddr Mib variable,” it is because the
Catalyst 1200 SNMP agent does not store the correct IP address in the
sysIpAddr MIB variable. You must use CiscoView to correct it. Select
Configure>Device, enter the correct IP address in the corresponding field,
and clickModify .

TrafficDirector 3.3 cannot be launched for interfaces with ifIndex values
greater than 1000.

Catalyst 1800
The device agent does not update the IP address table of MIB-II properly and
does not reflect the correct IP address information of all the device interfaces.
You cannot view the correct IP address information of the device by selecting
Device>Configure>IP Address Table.

You cannot create new static entries for IP Route Table and ARP Table
through CiscoView.

In the interface configuration (Port>Config>Interface), modifying the IP
parameters always displays an error message, but the modification is
successful.

You cannot change the bridge type of the FDDI port to sr-only or srt.

You cannot change the bridge type of the Token Ring port to srtb or tb-only.

The system time configuration is not included as part of device configuration.
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Catalyst 1900, Catalyst 2100, Catalyst 2800, EtherSwitch 1200, and
EtherSwitch 1400 Series Devices
CPW1200, CPW1220, CPW1400, CPW1420, Catalyst 1900, Catalyst 2100,
Catalyst 2800, and Catalyst 2820—The General Bridge window shows the
bridge information for VLAN1 only. Bridge information for other VLANs is
not available.

CPW1220, CPW1420, Catalyst 1900, and Catalyst 2820—In the CDP
Configuration Dialog, changing the transmission time of one port changes the
transmission time of all ports. This is a feature of the implementation of the
corresponding MIB objects in the device firmware. [CSCdi83959]

CPW1200, CPW1220, CPW1400, CPW1420, Catalyst 1900, Catalyst 2100,
Catalyst 2800, and Catalyst 2820—The Spanning Tree Protocol Window for
switched ports is available for ports in VLAN1 only. This window does not
show valid information for ports not in VLAN1.

If CiscoView for Cat1900 is invoked, the following message is displayed on
the console. You can ignore the message. [CSCdj62767]

Sess0 21 noSuchName 1 {{1.3.6.1.4.1.437.1.1.3.2.19.0 noSuchObject N/A}}

CPW 1420 and Catalyst 2820
On the front panel display of the device, the Connect and Disabled LEDs on
FDDI modules do not reflect the appropriate status.

Although a Monitor menu option is available for both FDDI and repeater
ports, this feature is not supported on these modules. [CSCdj57452]

TheConfigure>Module option is supported only for one module type, even
though it can be invoked for multiple module types.

There is a dependency between the CPW1420 and Cat2820. The CPW1420
device package will not run unless the Cat2820 package is installed.
[CSCdj64496].
CiscoView 4.1(1) Release Notes  21



CiscoView Notes and Caveats
Catalyst 2600
The Catalyst 2600 device package contains two versions of the enterprise
MIBs for the Catalyst 2600 switch:

• C2600_cisco.my—This MIB file is installed to support devices with
image versions prior to 2.2.1.

• C2600.my —This MIB file is installed to support devices with image
version 2.2.1 or later.

If you are using a MIB browser tool, you will see the MIB variables defined
in each of the above files, under different branches, at the same time, although
any particular Catalyst 2600 switch will respond to queries on only one of the
MIBs, based upon the release of software in the device. Cisco recommends
that you upgrade your Catalyst 2600 switches to version 2.2.1 or later.

CPW 2200 and Catalyst 2900
Under a heavy load condition, SNMP responses are slow. You might see an
“error, no response since....” message in the CiscoView status window. Select
Options>Propertiesand increase the Polling Frequency and Timeout values.
[CSCdi57962]

If the number of the embedded RMON agent is over 50, you cannot create any
new embedded RMON agent group for the new port. Use the Domain
Manager to uninstall the agent group from the unused port to free the memory
resource.

If you launch Switch/Port Zoom (if TrafficDirector is installed) from
CiscoView and then delete one of the RMON Agents using TrafficDirector,
you must relaunch CiscoView before launching Switch/Port Zoom again.

TrafficDirector 3.3 cannot be launched for interfaces with ifIndex values
greater than 1000.

When multiple ports are selected, the Port>Configure window does not
display the Broadcast Suppression category. This category is available only
for single port selection.

When you enable port security administration on a port, there may be
timeouts. If this happens, increase the SNMP timeout value to approximately
10 seconds.
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The WS-X2901 module shows the speed LED lit only when the speed is
configured as 100 Mbps and the port is connected.

The Port Utilization tool has been removed from the Tools menu and is now
available only on a per module basis on the Config>Module menu.

Catalyst 3000 Series
When you reinstall or perform a cvinstall -f of CiscoView 4.1 and integrate
with HP OpenView 4.11, you will see an error relating to theC3_2_0.myMIB
file display. This error is because of duplicate definitions in the Catalyst 3000
MIB files. To correct this problem, download a new copy of the Catalyst 3000
package from the CCO web site. This package resolves CSCdj03981.

When you access a stack with six or more devices, there might be some
significant performance problems. You can improve performance by
increasing the SNMP timeout settings.

The Catalyst 3000 software does not support RMON on either a stack or an
ATM port.

You might notice timeout messages and SNMP Set Failed messages when
using the EtherChannel Configuration tool. If this happens, increase the
SNMP timeout values for better performance.

If you are running version 2.0(1) of the Catalyst 3000 software, you will not
be able to drag a port to a VLAN that does not already have ports assigned to
it. You can fix this problem by upgrading to a later release of Catalyst 3000
software.

If you are running version 2.0(1) of the Catalyst 3000 software, changes to
Full/Half Duplex settings will not always be reported correctly. You can fix
this problem by upgrading to a later release of Catalyst 3000 software.

If you are running version 2.0(1) of the Catalyst 3000 software, the SAID
value entered when creating a new VLAN will be redisplayed as a different
value. However, the VLAN will have been created with the SAID value you
specified. You can fix this problem by upgrading to a later release of Catalyst
3000 software.

The Domain Configuration and EtherChannel Configuration tools are not
supported on Windows 95.

Because of restrictions in the Catalyst 3000 software, the WS-X3006B is
displayed in CiscoView as a WS-X3006A.
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If you launch Switch/Port Zoom (if TrafficDirector is installed) from
CiscoView and then delete one of the RMON Agents using TrafficDirector,
you must relaunch CiscoView before attempting to launch Switch/Port Zoom
again.

Catalyst 3900
CiscoView does not show the rear view of the Catalyst 3900 box.

When you attempt to drag port(s) to drop into one of the CRFs in the VLAN
table, CiscoView might exit with an error. To work around this problem, first
select the ports of interest, then bring the focus back to the VLAN Table
window, and then drag the selected port(s) and drop them into the desired
CRF.

TheConfigure...option under the Bridge Configuration category allows you
to view a current configuration only. It reports an error when you attempt to
configure new values for any parameter.

The Threshold Manager and TrafficDirector applications have not been fully
tested with the Catalyst 3900.

Catalyst 5000 Series
While integrating some device packages with HP OpenView for
HP-UX/Solaris or AIX NetView, some Catalyst 5000 device-specific traps
are not integrated into HP OpenView. [CSCdj63184]

After an online insertion/removal (OIR) event (also called a “hot-swap”),
CiscoView does not show the correct module or port status. The only way to
display the correct status is to reopen the device or relaunch CiscoView.
[CSCdj39860]

ATM, FDDI, and CDDI do not support Broadcast Suppression.

In machines that do not have a/tftpboot directory (such as a PC), an error is
displayed whenever the Upload/Download feature is invoked on a Catalyst
5000 module.

Do not use the Grapher in the CiscoView Monitor 10BaseT Group Switching
Ethernet window. Use the Monitor or TrafficDirector tools (if TrafficDirector
is installed) to see graphical views of the selected repeater ports.
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When you use the Switch Zoom menu (if TrafficDirector is installed) from
CiscoView to view multiple switch ports, the default configuration for the
Catalyst 5000 is to configure Statistics only. To see the Short-Term or
Long-Term history from Traffic Monitor, use the Domain Manager to
configure the Short-Term and Long-Term groups manually or use Segment
Zoom to view the port first.

When you use the Segment Zoom menu from CiscoView to view the port
segment, the default configuration for the Catalyst 5000 is Statistics,
Short-Term history, and Long-Term history.

If you see the message “Error: Entry or Group not present in Agent” when
invoking Segment Zoom, Switch Zoom, or Data Capture, the write
community string may not be matched with the device. If the community
string is matched and the problem still occurs, use the CiscoView Configure
Device menu to see whether the RMON capability is enabled.

When you select the repeater module port on a Catalyst 5000, it always uses
the first port of the selected segment to create the RMON agent group.

If all Catalyst 5500 slots are populated with modules and you experience
timeouts, increase the SNMP timeout value to 15 seconds.

The WS-X5213 and WS-X5213A modules show the 100 Mbps speed LED lit
only if the speed is configured at 100 Mbps and the port is connected.

Opening the FDDI/Ethernet Bridge category under Configure>Device can
display an “unknown error.” This is because of a problem with the device
software.

If a general error (genErr) is displayed when you change vlanPortIslStatus,
the selected port might not support ISL.

The values of ifAdminStatus and ifLinkUpDownEnable cannot be changed
on an ATM port.

Port duplex settings cannot be changed on ATM and FDDI ports.

The value portSpanTreeFastStart cannot be changed on ATM and FDDI ports.

Configuring ports to unsupported speeds returns a general error (genErr).
This is because of a problem in the device software.

The following list details the availability of Broadcast Suppression in terms
of pps (packets per second) or % (percentage) for modules on Catalyst 5000
series switches. A plus sign (+) means available, while a minus sign (-) means
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not. Modules not on this list do not have Broadcast Suppression. The
Broadcast Suppression feature is not available on ATM and FDDI.
[CSCdi90909]

Fasthub 100+ and 300 Series
For devices that have an expansion module, the port numbering is not
consistent with the management console. Ports 17 through 32 are listed in
CiscoView as Repeater 2: Port 1 through 16. [CSCdi77159]

After the first reset of the device, the user must set therptrResetMIB variable
to noReset (default value) before the next reset can be performed. This is
because of a problem on the device software and will be fixed in a later
release. [CSCdi77452]

CDP and CGMP Protocols Unsupported
The CPW 1200/1400 and Cat 2100/2800 devices do not support the CDP and
CGMP protocols. The CiscoView dialogs for these will return errors.

Module
Packets per
Second (pps) Percentage Note

WS-X5013 + +

WS-X5011 + -

WS-X5010 + +
% available with newer
hardware only

WS-X5113 + -

WS-X5111 + -

WS-X5213 + -

WS-X5020 + -

WS-X5114 + -

WS-X5223 + +

WS-X5224 + +

WS-X5213A + -
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Community String Mismatching
When the user enters values for the read-only, write-only, and read-writeId
with the Command Line Interface (CLI) commands, these values must match.
A mismatch results in noSuchName or timeout errors. To avoid these error
conditions, use identical community strings in CiscoView and corresponding
agents.

Duplicate Categories
When multiple ports of different types are selected, Port>Config may show
duplicate categories.

Switch Firmware
The following firmware versions must be used in the switches:

• Catalyst 2100 and 2800—v. 3.63 or higher

• EtherSwitch 1200 and 2800—v. 3.63 or higher

• EtherSwitch 10/100—v. 1.38 or higher

• Catalyst 1700—v. 1.38 or higher

• Grand Junction FastSwitch 10/100—v. 1.37 or higher

• Grand Junction FastSwitch 2100 and 2800—v. 3.62 or higher

Note The Grand Junction FastSwitch 2100 and 2800 are managed the same
as the Catalyst 2100 and 2800, respectively.

Switches
If you configure EtherChannel or Virtual Domains in Kalpana switch models
EPS2015RS, EPS2115RSM, and Pro16 while running version 9.0 firmware
with STP active, the map icons become red, and you receive the following
error message:

No response from the device

After restarting the system, deactivate STP before you reconfigure. This
problem is fixed in version 9.1 of the device firmware. [CSCdi41317]
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TrafficDirector
When launching TrafficDirector 4.1.3 from CiscoView make sure that/usr/lib
is included at the start of the LD_LIBRARY_PATH environment variable. A
segmentation fault may occur if it is not included.

If you launch Switch/Port Zoom from CiscoView and then delete one of the
RMON Agents using TrafficDirector, you must relaunch CiscoView before
attempting to launch Switch/Port Zoom again.

TrafficDirector 3.3 cannot be launched for interfaces with ifIndex values
greater than 1000.

Notes and Caveats for Access Products

Card Support for Cisco AS5300 Universal Access Servers
The following network processor modules are supported:

• as5300-4ct1

• as5300-4ce1

• pm-as5200-12m

• pm-dtd-6m

Card Support for Cisco AS5200 Universal Access Servers
The following network processor modules are supported:

• as5200-carrier(290)

• as5200-2ctl(291)

• as5200-2ce1(292)

• pm-as5200-12m(310)

• pm-as5200-12m-56k(311)

• pm-as5200-12m-v110(312)
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DS1 Line Channelized Info Not Displayed
A Cisco IOS defect causes CiscoView to not display the DS1 Line
Channelized info when a T1/E1 port is configured for cas-group. This is
applicable when the option is selected from the global menu item
Connection Info or if it is selected through the Line_ds1 config dialog box.
[CSCdj44707]

Status of T1/E1 Channel_ports for Channel-group
In the channel_modem view, CiscoView does not properly reflect the status
of the T1/E1 channel_ports (timeslots) that have been configured for
channel-group. This is a Cisco IOS software problem.

Card Support for Cisco 1600 Series Routers
The following WAN interface cards are supported:

• wic-csu-dsu-4

• wic-serial-1t

• wic-s-t-2186

• wic-s-t-2186-leased

• wic-u-2091

Card Support for 3600 Series Routers
The following WAN interface cards are supported:

• wic-1t

• wic-1dsu-56k4

• wic-1b-s/t

• wic-1b-s/t-ll

• wic-1b-u

The following network modules are supporrted:

• nm-4t

• nm-compr
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• nm-1e2w

• nm-2e2w

• nm-1e1r2w

• nm-1ct1-csu

• nm-2ct1-csu

• nm-1ct1

• nm-2ct1

• nm-1ce1b

• nm-2ce1b

• nm-1ce1u

• nm-2ce1u

• nm-4b-u

• nm-4b-s/t

• nm-8b-u

• nm-8b-s/t

• nm-4a/s

• nm-8a/s

• nm-4e

• nm-1e

• nm-4e

• nm-16a

• nm-32a

• nm-1fe-tx

• nm-1fe-fx

• nm-2v

• nm-1v

• vic-2em
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• vic-2fxs

• vic-2fxo

• nm-6dm

• nm-12dm

• nm-18dm

• nm-24dm

• nm-30dm

BRI Interface Information is not Correct
For the BRI interface in 8-port BRI cards or 4-port BRI card, the configure
and monitor information shown in CiscoView is not correct. The information
does not correspond to the correct BRI interface. This problem is present only
if you use Cisco IOS Release 11.2 and above. This is a Cisco IOS software
defect, CSCdj50307.

Hot Swap Does Not Work for Stacked Cisco 3600
The hot swap feature is not available for stacked Cisco 3600 series routers.

Whenever the async/sync port configuration is changed, you must reopen the
stack for CiscoView to update the async/sync port status. However, the hot
swap feature for the async/sync ports is supported for individual Cisco 3600
series routers.

Also, whenever the async/sync port configuration is changed in a 16/32 port
asynchronous network module, you must reopen the stack to obtain the latest
state. However, the hot swap feature for the async/sync ports is supported for
individual Cisco 3600 series routers.

Logical View and Channel Modem View Not Available in Stack View
The Logical view and Channel Modem Mapping view are not available for
stacked Cisco 3600 series routers. This support is scheduled for a future
release. However, for individual Cisco 3600 routers, Logical View is available
if a digital modem carrier card is present, and Channel Modem View is
available if a CT1/CE1 card is present.
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Fix for CSCdi69480 Invalid for Cisco IOS Versions Below 11.1(7)
The fix for defect CSCdi69480 (PRI/E1 interfaces missing in cardIfIndex
table) is integrated into Cisco IOS Release 011.001(007) and above. The
Cisco 3600 4.0(6.1) device package incorporates the fix and may not work
properly with Cisco 3600 series routers running Cisco IOS versions below
011.001(007).

Card Support for Cisco 4000, 4500, and 4700 Series
The following network processor modules (npm) are supported:

• npm-4000-fddi-sas

• npm-4000-fddi-das

• npm-4000-1e

• npm-4000-1r

• npm-4000-2s

• npm-4000-2e1

• npm-4000-2e

• npm-4000-2r1

• npm-4000-2r

• npm-4000-4t

• npm-4000-2t16s (for 4500 and 4700 routers only)

• npm-4000-4b

• npm-4000-8b

• npm-4000-ct1

• npm-4000-ce1

• npm-4000-1a

• npm-4000-6e

• npm-4000-1fe

• npm-4000-1hssi (for 4500 and 4700 routers only)
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FDDI Port Status Functionality
For 4000 series routers running Cisco IOS Release 10.2 or earlier, the
displayed status color is determined from the port’s administrative status
(ifAdminStatus) and operational status (ifOperStatus) values. This status
color will be the same on each connector. For devices running Cisco IOS 10.3
through 11.x, the displayed status color is determined from the Port Connect
State (fddimibPORTConnectState) for each connector. The possible values
for this status and the corresponding status colors follow: [CSCdi28566]

Notes and Caveats for High-End Business Products

Card Support for Cisco 7000 Series
The following interface processors and port adaptors are supported:

• cpu-7200-npe200

• vip2-50

• ct3ip - Phase II

• feip2 - tx/fx

• sa-encryption

• pa-oc3sm-mux-cbrt1

• pa-oc3sm-mux-cbr120e1

• pa-oc3sm-mux-cbr75e1

• pa-oc3mm-mux-cbrt1

• pa-oc3mm-mux-cbr120e1

• pa-oc3mm-mux-cbr75e1

• pa-ds3-mux-cbrt1

Status Status Color

disabled brown

standby brown

connecting blue

active green
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• pa-e3-mux-cbr120e1

• pa-jt2

• pa-4me1-bal

• pa-4me1-unbal

• pa-1e3

• pa-2e3

• pa-1t3

• pa-14e-switch

Can't Read DD(port-23.port-26.pos) for Fast Ethernet PA
When you try to open a horizontal-chassis device such as the Cisco 7204,
7206, or 7505 with a Fast Ethernet port adapter installed, the error message
“can't read ‘DD(port-23.port-26.pos)’: no such element in array” is displayed.
To fix this, upgrade to the latest Cisco 7000 CiscoView package at
http://www.cisco.com/cgi-bin/tablebuild.pl/cview40. [CSCdj16247]

CT3IP Interface Processor Card
No MIB object is associated with the test port on a CT3IP card.
[CSCdj18638]

Displayed ATM Connector Type
CiscoView 4.1 always displays the multimode fiber SC type of ATM
connector on AIPs, even when the media interface is of another type.
[CSCdi53420]

DS3 Config-Monitor Items Missing from Dialog Boxes
For pa-1e3 and pa-1t3 cards, DS3 Configuration does not appear in the config
rport dialog box. Also, DS3 Current Statistics and DS3 Total Statistics do not
appear in the monitor rport dialog box. [CSCdj60001]
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FDDI Port Status Functionality
For 7000/7500 series routers running Cisco IOS Release 10.2 or earlier, the
displayed status color is determined from the port’s administrative status
(ifAdminStatus) and operational status (ifOperStatus) values. This status
color will be the same on each connector. For devices running Cisco IOS 10.3
through 11.x, the displayed status color is determined from the Port Connect
State (fddimibPORTConnectState) for each connector. The possible values
for this status and the corresponding status colors follow: [CSCdi28566]

FEIP2 Interface Processors
CiscoView displays an FEIP2-FX interface processor as an FEIP2-TX for all
Cisco IOS versions before Release 11.1(11)CA. [CSCdj15831]

FEIP-FX Card Not Displayed
The feip-fx card does not appear in CiscoView. When the Cisco 7000 series
device comes up, you might see the error message “no such element in array.”
[CSCdj61077]

LEDs Not Shown for FDDI Interface
For devices running Cisco IOS Release 10.2, a FIP card’s PhyA and PhyB
LEDs do not appear lit in CiscoView. [CSCdj23023]

Flash File System
When performing the Squeeze operation on a Flash card, the error message
“Failed to Squeeze. Try increasing the timeout property under Options in the
Main window” might be observed even though the operation succeeds.
[CSCdj03172]

Status Status Color

disabled brown

standby brown

connecting blue

active green
CiscoView 4.1(1) Release Notes  35



CiscoView Notes and Caveats
High System Availability (HSA)
On 7513 and 7507 chassis, when the master RSP (Route Switch Processor) is
in use, the console port changes color on the CiscoView 4.1 display. However,
when a slave RSP is installed, its console port mirrors that of the master,
regardless of whether it is in use. [CSCdi49049]

Invalid Port Level FSIP Config Category
An invalid port level FSIP Config category will appear for devices with MIP
cards running Cisco IOS software earlier than Release 11.1. The dialog box
shows N/A for variables displayed in it, as these do not apply. [CSCdj23970]

Misidentified FastSerial Port Adapter
CiscoView might display a 4-port FastSerial port adapter (pa-4t) as a HSSI
adapter (pa-ah1t). [CSCdj17487, CSCdj17516]

Wrong Polling Results After Hot Swap
After an online insertion/removal (OIR) event (also called a “hot-swap”),
CiscoView does not show the correct module or port status. The only way to
display the correct status is to reopen the device or relaunch CiscoView.
[CSCdj39860]

Unknown Enumeration
In the DS1 Configuration dialog, dsx1LoopbackConfig is reported with an
unknown enumeration. [CSCdj17466]

LightStream1010
Ensure you are using the latest LS1010 device package (version 1.8). You can
download this package from CCO. [CSCdj59465]

To configure an LECS address for LS1010 from CiscoView, ServiceId needs
to be the following: 10.1.3.6.1.4.1.353.1.5.1.<Index>, where Index is the row
differentiator for configuring multiple LECS addresses. Index is an integer.

From CiscoView for LS1010, the ATM Traffic Descriptor table does not show
any rows. This is an agent bug. [CSCdj00685]
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Power Supply Display
By default, CiscoView 3.1(1) displays two power supplies for a Cisco 7000
router running Cisco IOS Release 10.2 and earlier. With Cisco IOS
Release 10.3 and later, power supplies are displayed based on
ciscoEnvMonSupplyState values.

Notes and Caveats for Online Help

Find Tab
Because of the way a master CiscoView contents file is used by the software
when multiple CiscoView device package help files are present, the list of
files to include when setting up a customized find operation contains multiple
items, called CiscoView. [CSCdj62089]

Online Help Oddities
There is a problem with the online help viewer, HyperHelp, intermittently
displaying the Help topic window when opening Help>Contents.

When you first open a help topic usingHelp>Contentsand click theBack
button, the HyperHelp viewer might display a blank window. This is a
HyperHelp bug. [CSCdi04758]

Cisco Connection Online
Cisco Connection Online (CCO) is Cisco Systems’ primary, real-time support
channel. Maintenance customers and partners can self-register on CCO to
obtain additional information and services.

Available 24 hours a day, 7 days a week, CCO provides a wealth of standard
and value-added services to Cisco’s customers and business partners. CCO
services include product information, product documentation, software
updates, release notes, technical tips, the Bug Navigator, configuration notes,
brochures, descriptions of service offerings, and download access to public
and authorized files.

CCO serves a wide variety of users through two interfaces that are updated
and enhanced simultaneously: a character-based version and a multimedia
version that resides on the World Wide Web (WWW). The character-based
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CCO supports Zmodem, Kermit, Xmodem, FTP, and Internet e-mail, and it is
excellent for quick access to information over lower bandwidths. The WWW
version of CCO provides richly formatted documents with photographs,
figures, graphics, and video, as well as hyperlinks to related information.

You can access CCO in the following ways:

• WWW: http://www.cisco.com

• WWW: http://www-europe.cisco.com

• WWW: http://www-china.cisco.com

• Telnet: cco.cisco.com

• Modem: From North America, 408 526-8070; from Europe,
33 1 64 46 40 82. Use the following terminal settings: VT100 emulation;
databits: 8; parity: none; stop bits: 1; and connection rates up to 28.8 kbps.

For a copy of CCO’s Frequently Asked Questions (FAQ), contact
cco-help@cisco.com. For additional information, contact
cco-team@cisco.com.

Note If you are a network administrator and need personal technical
assistance with a Cisco product that is under warranty or covered by a
maintenance contract, contact Cisco’s Technical Assistance Center (TAC) at
800 553-2447, 408 526-7209, or tac@cisco.com. To obtain general
information about Cisco Systems, Cisco products, or upgrades, contact
800 553-6387, 408 526-7208, or cs-rep@cisco.com.

Cisco documentation and additional literature are available in a CD-ROM
package, which ships with your product. The Documentation CD-ROM, a
member of the Cisco Connection Family, is updated monthly. Therefore, it
might be more up to date than printed documentation. To order additional
copies of the Documentation CD-ROM, contact your local sales
representative or call customer service. The CD-ROM package is available as
a single package or as an annual subscription. You can also access Cisco
documentation on the World Wide Web at http://www.cisco.com,
http://www-china.cisco.com, or http://www-europe.cisco.com.
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If you are reading Cisco product documentation on the World Wide Web, you
can submit comments electronically. ClickFeedback in the toolbar, select
Documentation, and clickEnter the feedback form. After you complete the
form, clickSubmit to send it to Cisco. We appreciate your comments.

This document is to be used in conjunction with theOverview for CiscoViewpublication.
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